Installation
The RSD2013 software is compiled to run on a Windows platform. It mainly consist out of two executables:
RSD2013_GUI.exe and RSD2013.exe. The first executable is the graphical user interface (GUI) which creates the
input files and can start up the RSD2013 simulations. The second executable is the effective simulation
program. After generating an input with the GUI or manually, you can run RSD2013_GUI.exe on the command
line to perform the simulation.
Installation of the RSD2013 software is easy. Simply unpack the compressed zip file to a location of your
choice and you are ready to use the software. The directories icons and templates should be left intact.
Renaming the RSD2013.exe executable will make running simulations through the GUI impossible.

Overview
The RSD2013 software is developed to simulate the reactive sputter process of a DC magnetron. It's focus is
on the possible hysteresis curve of this process. To this end, it solves the equations of the RSD2013 model, as
can be found in following reference. The nomenclature of the variables used here corresponds with the one of
this reference.
The RSD model calculates following variables:
the
the
the
the
the
the
the
the
the
the

pressure Pr of the reactive gas in the system
compound θr, chemisorbed θc and metal θm fractions on the target surface
compound θs and metal fractions on the substrate surfaces
metal concentration nM in the target subsurface region
compound concentration in the target subsurface region which is directly derived from nM
non-reacted implanted reactive gas concentration nR in the target subsurface region
consumptions Q t of reactive gas by the target
consumptions Q s of reactive gas by the substrate
amount of reactive gas Q p pumped away by the vacuum pump
amount of reactive gas Q in introduced into the vacuum chamber

To calculate these variables, the RSD model needs several input variables. These input variables are clarified
throughout the following sections.

Quick start
To run a first RSD simulation, you just double click the GUI executable RSD2013_GUI.exe . By default a
complete input is specified in the window tabs Method, Chamber, Target, Substrate and Output.

Default input.
To run this default simulation, you first have to save the simulation input. By choosing File > Save as ... in
the menu bar or pressing on the icon
, a window pops up to specify a saving location and a name for the
main input file. Choose as location the INPUT directory under the RSD program folder, and as name, for
example, my_first_simulation.in. Press the Save button. Two input files will be created, namely
my_first_simulation.in and my_first_simulation_OutputSpecs.in . The first file is the main input file, while
the second file is the input file specifying the generated output. These specifications are defined in the window
tab Output under Results.

Saving input main file.
The name of the main input file is now listed in the left side window and selected if it is blue highlighted.

List of input files.
To run the simulation of this selected input file, choose in the menu bar Simulation > Run selected or press
on the icon
. If everything goes well, a command window pops up, showing the progress of the simulation
which closes itself on the end of the simulation.

Running simulation.

To look at the simulation results you have to know where the output files are saved. To check this, go to the
window tab Output. In the first text field next to the button Choose, the location where the output files are
saved is given. By default the output location is the RSD program folder. The text field underneath gives the
prefix string with which every output file will start. By default this string is the name of the main input file.
Browsing to the output file location with Windows explorer, you will see two output files recognizable by the
extension .out . The file ending with summary.out is always generated. This file is updated during the
simulation run and shows the progress of the simulation as given by the command window. At the end of the
simulation it gives the elapsed time for this simulation run and its ending time. The other file ending with
hyst_steady.out contains the simulation results. As this is a steady state simulation, the reactive gas pressure
(second column) is increased up to the value 0.2 as specified in field Maximum pressure (Pa) in the window
tab Method, and subsequently decreased. The total number of pressure values that are calculated, by default
300, is specified by the field Calculated points under the same window tab Method. The columns of this
output file with the steady state solution gives the results of the following variables:
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

Q_in : flow of reactive gas introduced in the vacuum chamber
P_O2 : pressure of reactive gas
theta_s : spatial averaged compound fraction on substrate surface
theta_m : spatial averaged metal fraction on target surface
theta_c : spatial averaged chemisorbed fraction on target surface
theta_r : spatial averaged compound fraction on target surface
theta_mb : spatial averaged metal fraction of target subsurface layer
Q_p : reactive gas flow pumped away by the vacuum pump
Q_s : reactive gas flow consumed by compound formation on the substrate
Q_t : reactive gas flow consumed (or released) by the target

Example of output file.

Graphical User Interface (GUI)
The graphical user interface (GUI) is designed to create input files for a RSD simulation in an user-friendly
way. These input files can also be manually composed. Single or multiple simulation(s) can also be executed
from within the GUI. The GUI can be accessed by the executable RSD2013_GUI.exe . It most important task is
to compose the input files for the simulation executable RSD2013.exe. In fact, when starting a simulation from
within the GUI, it opens a command line and runs the RSD2013.exe executable with as single argument the
path of the main input file.

Concept
The concept of the GUI is doing the following tasks:
create new input files
load existing input files
edit input files
run single or multiple simulations
setup a series of simulations (see Scan)
In obtaining this, the philosophy of the GUI is as follows. The input of a single simulation is defined in the

window tabs, namely Method, Chamber, Target, Substrate and Output. The window at the left of the window
tabs lists the different simulations. Existing input files can be loaded or new input files can be created. The
name within the list is the name of the main input file of a particular simulation. After selecting one or more
items in the list, the user can let sequentially run these simulations.

Menu
The menu bar is located at the top of the GUI window. Through this menu the user can
open or load existing simulations (see File)
create new simulations (see File)
save changes to simulations (see File)
start simulations (see Simulation)
abort running simulations (see Simulation)
The action of every menu item is explained below.

File
Open
To open or load an existing main input file for editing. Made changes will be saved to the original main input
file and their included input files.

Hotkey: Ctrl+O
Open as copy
To open or load a copy of an existing main input file for editing. A new name and saving location is asked for
the copy. Changes are saved to the created copy. Only the main input file is copied which contains links to the
original included input files. Made changes to these included input files will as such be saved to the originals.
New
To internally open a new input item. It resets the fields in the window tabs to their default values. The input is
unsaved (and unlisted) until the Save or Save as ... item or icon is used.

Hotkey: Ctrl+N
Save
To save the changes made in the window tabs to the main and included input files. The made changes in the
window tabs are saved to the current selected (blue highlighted) item in the window list. If no main input file
is assigned yet, this action corresponds to a Save as ... action.
Selecting an other item in the window list, which is loaded into the window tabs, initiates this Save action for
the previous selected item.

Hotkey: Ctrl+S
Save as ...
To save and specify a new main input file for the current input of the window tabs. A new main input file is
generated together with the included input files. The main input file is added to the list of simulation inputs.
Exit
To exit and close the GUI window.

Simulation

Run selected
To execute the selected (blue highlighted) items of the window list in sequence.

Hotkey: Ctrl+R
Run all
To execute all the items of the window list in sequence, independent if they are selected or not.
Auto prefix
When ticked on, it will replace the value of the field Prefix for output files: in the window tab Output of all
items in the window list by a three digit number in the same order as the are listed. Numbering starts from
000.
Remark: When two or more items in the window list have the same prefix for the output files, a warning will
appear. In this case, simulation results will overwrite each other.
Kill current run
To kill or abort all running RSD simulations. In fact, it will kill all running RSD2013.exe processes on your
platform.

Hotkey: Ctrl+K

Help
About
To show information about the RSD2013 software and to whom it acknowledges.

Menu icons
The menu icons are a selection of common used menu actions. As such their functionality corresponds to a
particular menu action.

Open
See Open.

New
See New.

Save
See Save.

Save as
See Save as ....

Run selected
See Run selected.

Kill current run
See Kill current run.

About
See About.

Tabs
The window tabs graphically represent the information contained in the input files of a selected (blue
highlighted) item of the window list. Editing the fields of these tabs changes the simulation input and options.
All simulation options are visual within the window tabs. None used or relevant options or fields are grayed out
and unaccessible. They become (un)accessible depending on which simulation choices you make. For example,
when choosing the Steady state method in the window tab Method as solution method, then the fields
connected to the Time evolution method are irrelevant and as such grayed out.
Most fields have a restricted range of values that can be set. This restriction only applies to the GUI and can
be easily overruled by manually editing the input files.

Method
The window tab Method basically specifies how the RSD2013 model should be solved. As solution method, two
option are available the Steady state method and the Time evolution method. The choice between the two
methods is evidently exclusive.

Method window tab.
Steady state method
To solve the RSD2013 model in its steady state description. The reactive pressure Pr is stepwise increased up
to the Maximum pressure and subsequently decreased. The total number of reactive pressure Pr values that are
calculated are given by the field Calculated points.
Calculated points
To define the total number N of reactive pressure Pr values that are calculated in the Steady state method. So
the N/2 reactive pressure Pr values are each calculated twice, as they can be multi-valued. The first time for
an increasing reactive flow Q in and the second time for a decreasing reactive flow Q in .
Maximum pressure
To define the maximal reactive pressure Pr that is calculated in the Steady state method.
Time evolution method
To solve the RSD2013 model in its time description. The reactive sputter system is evolved in time defined by
a given reactive flow Q in . The time evolution of these reactive flows Q in is defined by the so called step file,
which is an included input file.
Flow stepfile
The step file is an included input file and defines the evolution of the reactive flow Q in for the time evolution
method.
The button New stepfile opens the window Creating step file where a new step file can be composed.

Creating step file window.
A step file consist out of numerical text lines. The first entry of such line defines the Start flow, the second
entry the End flow, the third entry the Step flow with which the Start flow is stepwise increased until it
reaches the End flow. The last entry is the Maximum time a given flow is set during a simulation. The Insert
button adds a line to the step file. The already defined lines are shown as a list in the upper window. By
clicking on a line in this list, the line is selected (blue highlighted). By pressing Del on the keyboard, you can
remove the line. By double clicking, the line is selected and loaded in the editing fields. After making changes

to the line, you can press the Save change button to save the changes to the original line. Pressing the Ok
button pops up a window to specify a saving location and to name the step file. A default name is suggested.
It is a concatenation of the string stepFile with the name of the main input file. Pressing the Open button
saves it to the step file.
The button New stepfile changes to Change stepfile when the full path of an existing step file is specified in
the text field. This can be done by direct editing this field or by using the Load stepfile button.
Pressing the Change stepfile shows the loaded step file in the window Creating step file for editing.
Two exclusive options define how the evolution of the reactive flow Q in is handled based on the step file.
Move to next flow if steady state is reached

steady state of the system is reached.

to set the next flow, based on the step file, when a

Force to next flow if maximum time is reached to set the next flow, based on the step file,
when a steady state of the system is reached OR when the maximum time of the previous flow is
elapsed.
Move to next flow if maximum time is reached to set the next flow, based on the step file, when the
maximum time of the previous flow is elapsed.

Integration
Time step
To define the integration step Δt of the explicit 4th order Runge-Kutta integrator of the ordinary differential
equations for the variables θm, θc, θr, θs and P;r.

Chamber
The window tab Chamber specifies the parameters connected to the gases in the chamber and the operation
conditions.

Chamber window tab.
Ar pressure
To define the fixed pressure Pi of the inert argon gas in the vacuum chamber.

Units : Pa
Temperature

To define the temperature T of the gases.

Units : K
Molar mass reactive gas
To define the molar mass of the reactive gas molecules.

Units : g mol-1
Ion current
To define the total ion current Itot towards the target.

Units : A
Pump speed
To define the volumetric pumping speed S of the vacuum system.

Units : L s -1
Volume
To define the volume V of the vacuum system occupied by the gases. This parameter is grayed out when
choosing the Steady state method.

Units : m 3

Target
The window tab Target specifies the properties connected to the sputtering target. Three additional options
are available:
a saturation limit on the implanted reactive species
a spatial resolved target by defining a current distribution
considering deposition on the target (=redeposition)

Target window tab (part 1).

Target window tab (part 2).
Molar mass
To define the molar mass of the metal element that is been sputtered.

Units : g mol-1
Mass density
To define the mass density of the metal in the target. A metal particle density n0 is calculated from the Mass
and the Molar mass . This density n0 is the density of the metal in the target independent if the metal
is bound to reactive atoms or unbound.

density

Units : g cm-3
Metallic yield

To define the yield of metal particles M per incoming ion if the metal is in the metallic state. No distinction is
made between inert or reactive incoming ions.

Units : M ion -1
Compound yield
To define the yield of compound particles MR z per incoming ion if the metal is in the compound state. No
distinction is made between inert or reactive incoming ions.

Units : MR z ion -1
Stoichiometry
To define the stoichiometry z of the compound formed on target (and substrate). Compound is described as a
compound particle MR z, with M the metal atom and R the reactive atom.
Effective sticking coefficient
To define the effective sticking coefficient αt for the target. It is the average probability for a gaseous reactive
particle (atom or molecule) to chemisorb on a metallic surface to form a chemisorbed particle.
Bulk reaction rate
To define the reation rate k with which reactive implanted atoms react with metal atoms still in the metallic
state to form compound particles.

Units : cm3 s -1 M(R) z
Saturation limitation
To optionally define a saturation limit for the amount of reactive species in the target. This saturation is
represented by the saturation function s(n M ,nR ) (= error function) which limits the amount of reactive atoms
that get implanted. The three choices are:
no saturation limit ( nR,max =∞)
abrupt s(n M ,nR ) is a step function (Δ nR =0)
smooth smooth growing limit (Δ nR >0)
none

In the case of an abrupt and smooth saturation, a Limit L has to be specified. This limit L defines the allowed
over or under stoichiometry according to the formula MR (1+L)z. This limit encloses as well the bounded as
unbounded reactive atoms.
For the case of a smooth saturation, an additional Spread S has to be specified. This spread S determines how
'fast' a complete saturation is established. The limitation starts from MR (1+L-S)z to a full saturation at
MR (1+L+S)z .
Mean
To define the mean Rp of the Gaussian distribution with which reactive ions or knocked on reactive atom gets
implanted into the target.

Units : nm
Deviation
To define the deviation dRp of the Gaussian distribution with which reactive ions or knocked on reactive atoms

get implanted into the target.

Units : nm
Knock-on
To define the knock-on yield &beta. This is the average probability that an incoming ion (inert or reactive)
knocks a chemisorbed reactive atom at the surface into the target.
Area
To define the area of the target that is sputtered.

Units : cm2
One-cell
The One-cell choice considers the target as spatial uniform. The ion current density is uniform and the state
of the target surface and subsurface is considered homogeneous.
Multi-cell
The Multi-cell choice considers the target as spatial resolved in a number of target cells. Two geometrical
shapes of the target are selectable circular or rectangular.
For the circular shape the partitioning in the radial dimension r has to be specified as well as the partitioning
in the azimuthal dimension theta . Ticking the Equal area box equals the area of each target cell by a nonequidistant partitioning of the radial dimension r.
For the rectangular shape the partitioning in the horizontal dimension x and in the vertical dimension y has to
be specified. These target cells are automatically equal in area.
With the button Load current profile the file location of the included input file current profile has to be given
or by direct editing the text box. The current profile file has to correspond with the chosen Shape .
Redeposition
By ticking the Redeposition box, the deposition of sputtered material back on the target is considered. Two
exclusive ways of defining this redeposition are available: a SIMTRA input or a Manual input .
For the SIMTRA input the deposition profile file for the target has to be provided. This file normally comes
from a SIMTRA simulation. With the button Load SIMTRA file the file location of the included input file
deposition profile has to be given or by direct editing of the text box. This file is added to an included input
file listing the deposition profile files of the target. For the moment this SIMTRA listing file will always contain
only one entry as only one deposition profile is connected to the target. Ticking the box Uniform deposition
will calculated based on the deposition profile file, the total fraction of sputtered material that is redeposited.
This amount will be equally divided over the target cells.
For the Manual input the Fraction of sputtered flux has to be defined. This is the total fraction of
sputtered material that is redeposited on the target. This fraction will be equally divided over the target cells.

Substrate
The window tab Substrate specifies the properties connected to the substrate surfaces. Two exclusive options
are available namely Uniform deposition and Deposition profile.

Substrate window tab.
Effective sticking coefficient
To define the effective sticking coefficient αs for the substrate. It is the average probability for a gaseous
reactive particle (atom or molecule) to chemisorb on a metallic surface to form a chemisorbed particle.
Uniform deposition
The Uniform deposition choice considers the substrate as spatial uniform. The deposition distribution is
uniform and the state of the substrate surface is considered homogeneous.
Area
When choosing Uniform deposition , the total collecting area of the substrate has to be specified

Units: cm2

Deposition profile
The Deposition profile choice considers the substrate as spatial resolved in a number of substrate cells.
Deposition profile files have to be provided for this option. This can be done by using the Load SIMTRA files
button. Multiple deposition profile files can be simultaneously loaded in that way. After clicking open, the file
locations are listed in the text field below. The text field Collecting area forms the list of the substrate areas
that the loaded deposition profiles represent. With each deposition profile file should correspond an area.
These deposition files are added to an included input file listing the deposition profile files and the
corresponding collecting area of the substrate. By default this listing file is saved at its Standaard file
location . Unticking this box let you specify an other location by either using the Choose button or by directly
editing the text field next to it. If you choose an existing listing file, the user has the choice to overwrite it or
to load the deposition profile files of this listing file.
The Collecting area items are in units of cm2 . Their value should always correspond to an area of a
rectangle, as the SIMTRA program always represent a surface on a rectangular grid.
Ticking the box Skip counts equal zero will exclude those substrate cells that are assigned a zero deposition
fraction. These substrate cells are considered to be not existing, and a value of -1 will appear in the output
file for those cells.

Output
The window tab Output specifies which results should be printed out and where to save them.

Output window tab (part 1).

Output window tab (part 2).
Output directory
To define the directory where all output files will be placed. This directory can be specified by direct editing of
the text field or by using the Choose button.
Prefix

To define the prefix string for the file name of all output files. By default this will be the file name of the main
input file. Ticking the Simulation >Auto prefix will attribute a number to the prefix field and gray out this
field.
Results
By ticking the check boxes, the desired output can be selected. The available outputs, those that are not
grayed out, depend on previous choices and selected options. For example, when choosing the One-cell in
the Target tab and Uniform deposition in the Substrate tab, only the Spatial averaged check box can be
chosen.
Ticking the Spatial averaged check box will create an output file with suffix steady.out in the case of the
Steady state method and a second output file with suffix time.out in the case of the Time evolution method.
Additional info about these output files can be found in the section Spatial averaged.
Ticking the Spatial resolved check box will be possible when choosing the Multi-cell option in the window
tab Target and/or the Deposition profile option in the window tab Substrate . The corresponding check
boxes will become available.
Two output formats can be chosen for the spatial resolved data: ASCII or binary. The binary format is much
compacter compared to the regular ASCII format. The structure of the numerical data is nevertheless the
same, only will every numerical be represented by a 32 bit IEEE float value.
Bulk profile means that 3 dimensional data is generated within a volume, while Surface profile means that
2 dimensional data is generated on a surface.

Following table summarizes the output possibilities:
Check box
Target

Variable Suffix string

Volume Surface Dynamic Static

Non reacted metal fraction

nM / n0

target_bulk_n_M.out

yes

no

yes

no

Unbound reactive fraction

nR / n0

target_bulk_n_f.out

yes

no

yes

no

Metal fraction

θm

target_surf_thetaM.out

no

yes

yes

no

Compound fraction

θr

target_surf_thetaR.out

no

yes

yes

no

Chemisorbed fraction

θc

target_surf_thetaC.out

no

yes

yes

no

Surface speed

vs

target_surf_surfSpeed.out

no

yes

yes

no

Erosion speed

ve

Area

I
At

no
target_surf_erosionDepth.out no
target_surf_Qt.out
no
target_surf_current.out
no
target_surf_area.out
no

yes
yes
yes
yes
yes

yes
yes
yes
no
no

no
no
no
yes
yes

Redeposition fraction

εt

target_surf_redepos.out

no

yes

no

yes

Compound fraction

θs

target_surf_thetaS.out

no

yes

yes

no

Reactive flow

Qs

target_surf_Qs.out

no

yes

yes

no

Deposition fraction

εs

target_surf_depos.out

no

yes

no

yes

Erosion depth
Reactive flow
Current

Qt

target_surf_erosionSpeed.out

Substrate

The selection of data and the saving format is stored in an included input file. By default this included input
file is saved at its Standaard file location . Unticking this box let you specify an other location by either
using the Choose button or by directly editing the text field next to it. If you choose an existing input file with
output specifications, the user has the choice to overwrite it or to load the output specifications from this file.

List
The window list lists the loaded or created simulation inputs. An item in the list is represented by the filename
of the main input file connected to a simulation. By clicking on an item in the list, the simulation input is

loaded into the window tabs for editing.
The simulation input which is current in scope is blue highlighted in the list. Selecting another item in the list
will save the made changes in the previous simulation input.
Multiple items in the list can be selected (=blue highlighted) to perform one of the following actions:
Remove the item from the list by pressing the Del key. Note that the input files are NOT removed from
your disk, only from the list.
Run the simulation by pressing Simulation >Run selected in the menu bar or the menu icon.
Right-clicking with the mouse on a selected (=blue highlighted) item in the list shows the following actions:
Scan

Scan
The Scan action allows to do a parameter scan. This action is executed on a selected simulation input from the
window list. A limited number of parameters of this simulation input can then be varied. For each parameter
combination, a new simulation input will be generated and as such be inserted as a new item in the window
list.
Selecting this Scan action for an item in the window list pops up the scan window. Two lists are defined: Fixed
parameters and Varied parameters . The Varied parameters list is initial empty. Items of the Fixed parameters
list can be placed in the Varied parameters list by the right arrow and put back by the left arrow.

Scan window, one varied parameter.
Selecting an item in the Varied parameters list let you define a value range over which this parameter should
be varied at the bottom of the window. Start value sets the lower limit of this range, while End value sets
the upper limit. Number of steps sets the number of parameter values over this range. The lower and upper
limit should be counted in.
Multiple items in the Varied parameters list results in combined parameters sets. For example, if you have two
items in the Varied parameters list, each with a Number of steps of 3, then 9 (= 3 x 3) simulation inputs will
be generated. The total simulation inputs that will be generated, is showed in the non-editable Total steps
field.

Scan window, two varied parameter.
Pressing Ok will generate the simulation inputs and add them to the window list. The file names of the main
input file of each item is automatically assigned. The filename of the original main input file is concatenated
with the string scan , a keyword characteristic for the varied parameter and a number starting from 0 to count
the variations. Note that all generated simulation inputs will share the same included input files.

Window list with one varied parameter.

Window list with two varied parameter.

Command line
The RSD2013 simulation software can be used without the GUI. The executable RSD2013.exe can directly be
executed on a command line if provided with a valid single argument. This argument is the absolute path of a
main input file or the relative path with respect to the program directory (where the RSD2013.exe executable is
located). This is useful if you want to run the RSD2013 simulation in a script.
This main input file and the included input files where it references to, can manually be edited or be created
by the GUI.

Input files
The input files define all the input needed for a successful RSD2013 simulation. Two types of input files are
distinguished:
A main input file which contains input parameters, simulation options and path references to the included
input files.
The included input files define more specific input data and options for a simulation or further path
references to included input files.
Some input files are allowed to start or contain comment lines. Those file usually begin with an explanation of
the structure of that input file. A comment line always starts with #.

Main
The main input file is the input file which is provided to the simulation executable RSD2013.exe. It contains all
data and references to data needed for running the simulation. It is a text based file.
The structure of the file is as follows. Every line starting with # is considered a comment line and is ignored.
Every other line defines input and starts with the keyword rowXXX, where XXX is a number. This keyword
rowXXX is omitted when reading in the file. Nevertheless, the line number of each text line defines which kind
of parameter, option or reference should be defined. Explanation of which kind of information is expected on
each line is given in the comment lines starting this file.
As input restrictions are only checked within the GUI, their will no be any validity check of the give input data.
Some additional simulation options can be available which are not (yet) included in the GUI.

Included
The included input files are all other input files then the main input file. The main input file contains references
to these included input files, but included input files can also contain further references to other included input
files.
A description of the included input files that RSD2013 makes us of is given below.

Step
The step file defines the evolution of the reactive flow Q in for the time evolution method.
This input file can be edited or loaded in the window tab Method>Flow stepfile when choosing the Time
evolution method.
The step file is a text based file which consist out of numerical text lines. Each line defines a range over which
the reactive flow is varied. The first entry of such a line defines the start flow, the second entry the end flow,
the third entry the step with which the start flow is stepwise increased until it reaches the end flow. The last
entry is the maximum time a given flow is set, depending on the chosen option for the evolution of the
reactive flow.
The first none comment line should contain the number of flow ranges (or numerical text lines) that are
specified. The comment lines starting the file explain the structure of this file.

Current profile
The input file with the current profile defines how the total ion current is distributed over the target. Two types
of current profile are possible depending on the shape of the target: a circular or a rectangular target.
The current profile file is a text based file. The first non comment line is the keyword circular or rectangular
that can be enclosed by comment lines. The numerical text lines define the profile. The profile should not be
necessarily normalized.
For the circular case, only an one dimensional radial profile is considered. The first entry of each line is the
radial distance, the second entry is the value of the profile at that position. The radial distance is rescale to
the target size.
For the rectangular case, a two dimensional rectangular profile is considered. The profile is defined on a
matrix. The number of columns corresponds with the partitioning of the target in the y dimension while the
number of rows with the partitioning in the x dimension. Each element of the matrix corresponds to the value
of the profile.

Deposition profile
The deposition profile files define which fraction of the sputtered material is deposited on which surface area.
The files are text based and matrix structured as the output deposition files from the SIMTRA software. The
first two entries on the first line define respectively the number of rows and columns. The rest of the line is
ignored. All following lines define the matrix.
The deposition profile files connected to the substrate (or the target) are listed and referenced in a separate
file. This file is structured as follows. The first non comment line of the file gives the number of included
deposition profile files. Each following couple of lines represent a deposition profile with on the first line the
full path or relative path to the deposition profile file, while on the second line the area corresponding to the
deposition profile. This area should take into account the full rectangular matrix of the profile, also when their
are (ignored) zero elements.
Substrate
Several deposition profile can be connected to the substrate. These deposition profile files and their connected
areas can be assigned when choosing Deposition profile in the window tab Substrate .

Target
Only one deposition profile can be connected to the target, as only one target is considered for the moment.
The deposition profile file can be assigned when choosing Multi-cell , Redeposition and SIMTRA input in the
window tab Target.

Output specs
The file with the output specifications determines which output will be generated when a simulation is
executed. It's appearance is closely related to the window tab Output.
To each kind of output is a keyword linked. When this keyword is not preceded by x, o or v, this output is not
generated. The x is used for a checkbox, the o for a radiobutton and v for a choice in a roll-down list. An
example is given.

Example of file with output specifications.
In this example the spatial averaged variables are generated, the spatial resolved metal fractions on the target
are generated in an ASCII format and in binary format the spatial resolved compound fractions on the

substrate are generated.

Output files
Output files always have the extension .out . Which output files are produced, is determined by the output
specification file or in the window tab Output. A summary of the simulation run is always generated and is
recognized by the ending string summary.out. The file name of each other output file starts with the chosen
Prefix and ends with an unique string.

Spatial averaged
The output file with the spatial averaged output ends with the string hyst_steady.out . For the Steady state
method, it outputs in each column the following steady state variables
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

Q_in : flow of reactive gas introduced in the vacuum chamber
P_O2 : pressure of reactive gas
theta_s : spatial averaged compound fraction on substrate surface
theta_m : current weighted averaged metal fraction on target surface
theta_c : current weighted averaged chemisorbed fraction on target surface
theta_r : current weighted averaged compound fraction on target surface
theta_mb : current weighted averaged metal fraction of target subsurface layer
Q_p : total reactive gas flow pumped away by the vacuum pump
Q_s : total reactive gas flow consumed by compound formation on the substrate
Q_t : total reactive gas flow consumed (or released) by the target

When choosing for the Time evolution method, this file contains the values of the variables at the end of a
flow step. Additionally, an extra output file is generated which ends with the string hyst_time.out . This file
contains the same variables as above, but adds an 11 th column with the time elapsed in the simulation.
11. t : time in the simulation
The spatial averaged variables correspond with this time. Every 255 time steps the value of these variables
are added to the file.

Spatial resolved
When the target and/or the substrate is spatial resolved by defining respectively a current profile and/or a
deposition profile, spatial resolved output can be generated. We consider spatial resolved output on a surface
(2D) for the target and the substrate or within a volume (3D) for the target. The format how this data is
written to the files can be simple ASCII or in a binary format. In the binary format the structure is the same
as for the ASCII format, but every number is binary represented by a 32 bit IEEE float value.

Surface (2D)
Surface resolved output can be generated for the target and for the substrate when choosing a current profile
and a deposition profile respectively. A table listing the different variables which can be resolved on a surface
is given under Results.
The format of the file is as follows. The first entry of the first line of the file is the number of columns which
equals the cells in the x or radial dimension. The rest of the first line numbers the columns starting from zero.
The first entry on each following line numbers the rows which equals the cells in the y or azimuthal dimension.
The following entries on each line represent the variable value in the matrix.
The data on the surface is saved at every steady state point sequentially, restarting the row numbering for
each point. A value of -1 means this surface cell is not considered in the simulation. For the different substrate
surfaces, the file names are numbered in the same way as they occur in the input file listing the deposition
profiles.

Volume (3D)

Volume resolved output can be generated for the target when choosing a current profile. A table listing the
different variables which can be resolved within a volume is given under Results.
The format of the file is as follows. The first entry of the first line is 200, the number of columns which equals
the in-depth points where a fraction is defined. The rest of the first line defines the depth (in cm) where a
variable is resolved. This depth stretches over the implantation zone (which equals Rp + 3dRp for a Gaussian
profile). The first entry on each following line numbers the rows which equals the number of surface cells
(product of the number of cells in the y or azimuthal dimension and of the number of cell in the x or radial
dimension). The numbering starts with the number of cells in the y or azimuthal dimension for a fixed x or
radial cell. The following entries on each line represent the in-depth fractions for the corresponding surface
cell.
The data within the volume is saved at every steady state point sequentially, restarting the row numbering for
each steady state point.

End remark
The author will be grateful if you make notice of any mistake or typo occurring within this manual. Feel free to
contact him at koen.strijckmans@ugent.be.

